IE 150 Marine

Generator, Shore, and BTB

V6EVLYEBBLY

Operator's manual

@ Improve
Tomorrow e

Adni
o PR ki
i B, M o
a o a [
- 55_DOéa #3318
— .-.-!
I
= o — ] < b
— = ke B =
e '.-‘11‘ g e
-""! '
3
— -
=
E -
1 ) -
f == ) =
" / -
1 Ll
- b &
ey
T =
I. £ ar. K O —
- ) P T T
| ] » =5
] ¥ B :
.| = -.—:& -
Loglt N o = —
. pr- ey — A
— = - gl I s
LY -y -} il l";__. 1 i
= il
i 5 s
Wi T ol - Y Ep ——
£



1. Introduction

1.1 SYyMDOIS fOr hazard STAt@MENTS................cooooi ettt 3
1.2 AbOUL the OPEIrator'S MANUAL. ..ottt bbbttt 3
L.BWANINGS QN SAFETY..........ooooooo ettt sttt 4
oA LAl INFOIM@TION...........cooooo ettt .4
2. Getting started
2.1 ABOUL CONEIOIIET OPEIFAION...................oooe sttt
211 DISPIAY SEELINGS. ..ottt 5
3. About the iE 150 Generator
BADISPIAY JQYOUL . ...........oooe e 6
BL2 IMIIMIC FUNCHION............ooo sttt S S8R5SR 7
BB RUNNING MOUES............oooiioeoites ittt sss st et ss 5828545845885 58585888 .8
3.4 Exhaust after-treatment (TIer 4/STAg@ V) ................c oo sssssssssssss s sssssssssss s sssssssssss s essssssssssssssssessnos 8
4. About the iE 150 Shore
AADISPIAY TAYOUL.............ooooio ettt 12
A2 MIMIC FUNCRION............ooooio ettt 13
A3 RUNNING MOMES............. oottt eeess e esss et s8££ 14
5. About the iE 150 BTB
BADISPIAY TQYOUL...............ooooee oot 15
B2 IMIMIC FUNCRION..........o sttt s8R 85888 .16
B.B RUNNING MOUES............ooooii ittt stse st sttt 5855255888885 8548551585858 16
6. Menus
BT IMENU STIUCTUNE. ...ttt s s e84t 18
6.2 PArAMEEEIS MENU.............ooooiee sttt s s s 5484884ttt 18
B.2.T IMENU NUMDEI Sttt 19
6.2.2 The JUMP tO PAramMELEr fUNCHION. ..ottt 19
B.3 VIBW IMONUL........oooiooooi ettt 20
B.3.1 DUSPIAY VIEWS.....oo oottt 488510558544 20
B.3.2 DSPIAY TEXT oottt sttt .22
B.4 STATUS TEXES. ...ttt sttt S s s s sS SRR 23
B.5 SEIVICE VIBW.........coooooooooe st 8 22525542000 27
6.6 GENEIAI SNOFTCULS ...ttt sttt .27
6.7 IE 150 GENEIALON IMENUS................o.ooooeeeeeieeeee s sss st ss st 2t 210 28
B.7.1 1] SEOUUD MIBNUL. oottt eeeass e esss st etk 8 RS8R 28
6.7.2 ENQGING SNOTTCULS MENU....oouiiriiiiiiireiiieeciiiee et eess st ssss e ses ettt 2888888 29
B.7.2.1 ECU DIBGNOSE ...oumveerreeireeeeseeeiiseeeeesesesssssssssssssssssesessseessss s ssss e o814 £581 5814558588008 44881080888k 29
B.7.2.2 FOICE REGENEIATION. ..ottt eses st s8££k 29

7. Alarm handling and log list

ZAAIGIM NANAIING..........coooio sttt s8R 30
701 SEIF-CRECK BITOIS. ..ottt sttt 5858585000 31
T2 LOGS MENU..........oieee sttt et et s s s 8185458258584 4 1541548585858k .31

Operator's manual 4189341439A EN Page 2 of 32



1. Introduction

1.1 Symbols for hazard statements

This shows dangerous situations.

If the guidelines are not followed, these situations will result in death, serious personal injury, and equipment
damage or destruction.

/I\ WARNING

damage or destruction.

/A\ CAUTION

This shows low level risk situation.

If the guidelines are not followed, these situations could result in minor or moderate injury.

NOTICE

This shows an important notice

This shows potentially dangerous situations.
A If the guidelines are not followed, these situations could result in death, serious personal injury, and equipment

Make sure to read this information.

1.2  About the operator's manual

This document gives the necessary information to operate the controller.

/\ CAUTION

Read this manual

Read this manual before you operate the system. Failure to do this may result in personal injury and damage to
the equipment.

Intended users of the operator's manual
The operator's manual is for the operator that uses the controller regularly.

The manual describes the LEDs, buttons and screens on the controller, alarm handling, and the logs menu.
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1.3  Warnings and safety
Factory settings

The controller is delivered pre-programmed from the factory with a set of default settings. These settings are based on
typical values and may not be correct for your system. You must therefore check all parameters and settings before using
the controller.

Data security

To minimise the risk of data security breaches:

* As far as possible, avoid exposing controllers and controller networks to public networks and the Internet.
« Use additional security layers like a VPN for remote access, and install firewall mechanisms.

o Restrict access to authorised persons.

1.4  Legal information
Third party equipment

DEIF takes no responsibility for the installation or operation of any third party equipment, including the genset. Contact the
genset company if you have any doubt about how to install or operate the genset.

Warranty

NOTICE

0 Warranty
The controller is not to be opened by unauthorised personnel. If opened anyway, the warranty will be lost.

Disclaimer
DEIF A/S reserves the right to change any of the contents of this document without prior notice.

The English version of this document always contains the most recent and up-to-date information about the product. DEIF
does not take responsibility for the accuracy of translations, and translations might not be updated at the same time as the
English document. If there is a discrepancy, the English version prevails.

Copyright
© Copyright DEIF A/S. All rights reserved.

Software version

This document is based on the iE 150 software version 1.33.0.
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2. Getting started

2.1 About controller operation

The iE 150 Generator controller contains all the functions needed to protect and control a genset, and the genset breaker.

The iE 150 Shore controller protects and controls the system and a shore connection breaker, when a shore connection is
connected.

The iE 150 BTB controller protects and controls a bus tie breaker. The power management system manages the busbar
sections.

Power management system

iE 150 controllers can work together in a power management system (PMS). This includes synchronisation, island operation,
and running parallel to the shore connection. The PMS can automatically start and stop gensets, and open and close
breakers. You can also use iE 150 in power management systems with other DEIF controllers.

Buttons and LEDs

Use the buttons to operate the system. You can change running modes, stop alarms, see the shortcut menu, and navigate
the controller. You can only use the start and stop buttons and the buttons to open and close the breakers in MANUAL
mode and No reg mode. Use the mimic function to select how the control buttons and LEDs are shown on the controller's
display.

Display screen

Use the display screen to:

¢ See the operating status

* See the alarms and logs list

« Monitor the exhaust after-treatment (Tier 4/Stage V)
« Configure the controller settings and parameters

211 Display settings
To adjust for ambient lighting, configure the display settings.

Parameters > Basic settings > Controller settings > Display > Display control

S S ™ S

9151 Backlight dimmer Oto15*
9152 Green LEDs dimmer 1Tto 15 * 15
9153 Red LEDs dimmer Tto 15 * 15
9154 Contrast level -20 to +20 0
9155 Sleep mode timer 1t0 1800 s 60 s
9156 Enable (Sleep mode timer) 8:;': ON
OFF

9157 Alarm Jump ON ON

. . . Bar/Celsius .
9158 Engineering units PS|/Fahrenheit Bar/Celsius

NOTE * Low numbers are minimum brightness and high numbers are maximum brightness.
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3. About the iE 150 Generator

3.1

Display layout

1

Power

Display screen

Navigation
buttons

@ Enter button
e Back button

@ AUTO mode

@ Silence horn
@ Shortcut

menu

Manual mode

Breaker symbols

Green: The controller power is ON.
OFF: The controller power is OFF.

Resolution: 240 x 128 px.
Viewing area: 88.50 x 51.40 mm.
Six lines, each with 25 characters.

Move the selector up, down, left and right on the screen.

Confirms the selection

Go to the previous page.

The controller automatically starts and stops (and connects and disconnects) gensets. No
operator actions are needed. The controllers use the power management configuration to
automatically select the power management action.

Stops an alarm horn (if configured) and enters the Alarm menu.

Access the Engine and General shortcuts, Jump menu, Mode selection, Test, Lamp test, First
priority selection, Store common settings, and Regulator shortcut.

The operator or an external signal can start, stop, connect or disconnect the genset. The
generator controller cannot automatically start, stop, connect or disconnect the genset. The
controller automatically synchronises before closing a breaker, and automatically deloads before
opening a breaker.

Green: Breaker is closed.
Green flashing: Synchronising or deloading.
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No. |Name Function

Red: Breaker failure.

10 . Open breaker Push to open the breaker.

1 . Close breaker Push to close the breaker.

Green: Generator voltage and frequency are OK. The controller can synchronise and close the
breaker.

12 Generator Green flashing: The generator voltage and frequency are OK, but the V&Hz OK timer is still
running. The controller cannot close the breaker.
Red: The generator voltage is too low to measure.

Green: There is running feedback.
13  Engine Green flashing: The engine is getting ready.
Red: The engine is not running, or there is no running feedback.

14 . Stop Stops the genset if manual mode is selected.

15 . Start Starts the genset if manual mode is selected.

3.2  Mimic function

Parameters > Basic settings > Controller settings > Display > LED mimic
Parameter no. Item Range

Standard with genset

. Standard

6082 LED mimic Guided with genset
Guided

Standard

The control buttons and LEDs are shown.
If you stop the genset, the motor/generator symbols are not shown.

Standard with genset

The control buttons and LEDs are shown.

If you the stop the genset, the motor/generator symbols are shown
in red.

Guided

Active control buttons and LEDs are shown inactive are not shown.
Example: The controller is in MANUAL mode, and the genset is not
operating. Only the start button is shown, as this is the only
possible action.

Guided with genset

Active control buttons, LEDs and the motor/generator symbols are
shown, inactive are not shown.

Example: The controller is in MANUAL mode. The genset is not
operating. The only possible action is to start the genset, and so
only the start button and the red motor/generator symbols are
shown.
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All Mimic settings

The breaker symbol is shown in red:
» Breaker position failure
* Breaker close failure

The breaker symbol flashes green:
e The controller is synchronising
« The controller is de-loading

3.3  Running modes

The iE 150 Generator controller has four running modes, and a test mode. To configure the running mode push the Shortcut

button and select Running Modes. Configure the test mode in Settings > Power set points > Test. Torun the

test push the Shortcut button and select Start Test.

Mode Description

The controller automatically starts and stops (and connects and disconnects) the genset. The operator cannot
AUTO start a sequence manually. The controllers use the power management configuration to automatically select
the power management action.

The controller cannot automatically start, stop, connect and disconnect the genset. The operator or an external
MANUAL signal can start these sequences. The controller automatically synchronises before closing a breaker, and
automatically de-loads before opening a breaker.

The operator can use the digital increase/decrease inputs (if they are configured) and the Start and Stop

No re . . . .
9 buttons. When the genset starts in manual mode, it starts without subsequent regulation.

BLOCK The controller cannot start a sequence. Select the block mode when you do maintenance work on the genset.

Test The test sequence starts when you select the test mode.

NOTE The genset shuts down if you select the block mode while the genset is operating.

3.4 Exhaust after-treatment (Tier 4/Stage V)

AGC 150 meets the Tier 4 (Final)/Stage V requirements. The user can use the display to monitor (and control) both the
engine, and the exhaust after-treatment system.
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After-treatment page
6 7 8

4—Hftertreatn9nt

| _
s—DG BLOCKED FOR HTART
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F—EEEEHEPﬂtlDH active

DEF Ie\{eI: 32.0%

15 14 13 12
“ Referent
1 After-treatment status
2 Engine emission system failure

3 Diesel Particle Filter (DPF)

4 Page name

5 Controller status

6 Diesel Particle Filter (DPF) Inhibit

7 High temperature - Regeneration

8 HC burn-off

9 Engine emission system failure level
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Emission failure or malfunction.

Regeneration is needed.

- b . o . oLl
== } Regeneration is inhibited.

-F-'j There is a high temperature and regeneration is in process.

Hydrocarbon accumulation that requires burn-off.

- |-"3:.
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Emission failure or malfunction, with the severity.
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10 Diesel Particle Filter (DPF) level
1 DEF level warning

12 DEF shutdown

13 DEF level inducement

14 Diesel Exhaust Fluid (DEF)

15 DEF level

Engine dashboard
5

ey

-E._J}
HIGH

-E-"}}

,da}

-—-.J

E

Regeneration needed, with the severity.

Low DEF level.

DEF problem stops normal operation.

Mid-level inducement.

Severe inducement.

DEF quality is low.

The DEF level.

+— DG BLOCKED |

-OR !

s TAR

—

s—Engine dashboard

: {?T]Hﬂﬁﬂlﬁmil1fﬂrzhﬁj333? 9

By A T D B
DEF level: , 32.0% all?

15 14
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g

1

10

1

12

13

14

15

NOTE

Water in fuel

Engine interface status

Page name

Controller status

Engine interface status

Engine interface status

Cold start

High engine coolant temperature

Low engine oil pressure

Fuel filter clogging

Air filter clogging

LIMIT lamp

Oil change

High engine oil temperature

DEF level

(4

B

1

There is water in the fuel.

An engine warning.

An engine shutdown.

An engine malfunction.

The engine is cold.

The engine coolant temperature is high.

The engine oil pressure is low.

The fuel filter is blocked.

The air filter is blocked.

Only for MTU engines.

The engine needs an oil change.

The engine oil temperature is high.

The DEF level.

Grey symbols show that communication is available for the referent. An engine type might not support all of the

referents.
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4. About the iE 150 Shore

4. Display layout

Green: The controller power is ON.
OFF: The controller power is OFF.

1 Power

Resolution: 240 x 128 px.
2  Display screen Viewing area: 88.50 x 51.40 mm.
Six lines, each with 25 characters.

Navigation

Move the selector up, down, left and right on the screen.
buttons

@ Enter button Confirms the selection

4 e Back button Go to the previous page.

@ The controller automatically connects and disconnects the shore connection. No operator
5 AUTO mode actions are needed. The controllers use the power management configuration to automatically
button select the power management action.

6 @ Silence horn  stops an alarm horn (if configured) and enters the Alarm menu.
button

7 e Shortcut Access the General shortcuts, Jump menu, Mode selection, Test, and Lamp test.
menu button

The operator or an external signal can connect or disconnect the shore connection. The shore
@ controller cannot automatically connect or disconnect the shore connection.
The controller automatically synchronises before closing a breaker, and automatically deloads
before opening a breaker.

Manual mode
button
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No. |Name Function

Shore connection Green: The voltage and frequency are OK. The controller can synchronise and close the breaker.

9 symbol Red: Shore connection failure.

Green: Breaker is closed.
10 Breaker symbols Green flashing: Synchronising or deloading.
Red: Breaker failure.

1 ‘ Open breaker Push to open the breaker.

12 ‘ Close breaker Push to close the breaker.

OFF: Power management application.
13  Load symbol Green: The supply voltage and frequency are OK.
Red: Supply voltage/frequency failure.

4.2 Mimic function

Parameters > Basic settings > Controller settings > Display > LED mimic

Parameter no. Item RET [

o Standard
6082 LED mimic Guided
Standard

The LEDs are shown.

Guided

Active LEDs are shown and inactive are not shown.

Example: The controller is in MANUAL mode, and the breakers are
closed. Only the Open breaker symbols are shown, as this is the
only possible action.

All Mimic settings

The breaker symbol is shown in red:
« Breaker position failure

o Breaker close failure

The breaker symbol flashes green:
e The controller is synchronising
« The controller is de-loading
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4.3  Running modes

The iE 150 Shore controller has three running modes, and a test mode. Push the Shortcut button and select Running
Modes to configure the mode. Configure the test mode in Settings > Power set points > Test. Torun the test push

the Shortcut button and select Start Test.

T L

The controller automatically connects and disconnects the shore controller. The operator cannot start a
AUTO sequence manually. The controllers use the power management configuration to automatically select the
power management action.

The controller cannot automatically connect and disconnect the shore controller. The operator or an external
MANUAL signal can start these sequences. The controller automatically synchronises before closing a breaker, and
automatically de-loads before opening a breaker.

Test The test sequence starts when you select the test mode.

BLOCK The controller cannot start sequences. Select the block mode when you do maintenance work.
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5. About the iE 150 BTB

5.1

Display layout

1

Power

Display screen

Navigation
buttons

@ Enter button
e Back button

@ AUTO mode
button

@ Silence horn

button

@ Shortcut

menu button

: Manual mode

button

Breaker symbols

Green: The controller power is ON.
OFF: The controller power is OFF.

Resolution: 240 x 128 px.
Viewing area: 88.50 x 51.40 mm.
Six lines, each with 25 characters.

Move the selector up, down, left and right on the screen.

Confirms the selection

Go to the previous page.

The controller automatically joins and splits the busbar. No operator actions are needed. The
controllers use the power management configuration to automatically select the power
management action.

Stops an alarm horn (if configured) and enters the Alarm menu.

Access the General shortcuts, Jump menu, and Lamp test.

The operator or an external signal can join or split the busbar. The BTB controller cannot
automatically join or split the busbar. The controller automatically synchronises before closing a
breaker, and automatically deloads before opening a breaker.

Green: Breaker is closed.
Green flashing: Synchronising or deloading.
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No. |Name Function

Red: Breaker failure.

10 . Open breaker Push to open the breaker.

1 ‘ Close breaker Push to close the breaker.

5.2  Mimic function

Parameters > Basic settings > Controller settings > Display > LED mimic

Parameter no. Item Range

. Standard
6082 LED mimic Guided
Standard

The LEDs are shown.

Guided

Active LEDs are shown and inactive are not shown.

Example: The controller is in MANUAL mode, and the breaker is
closed. Only the Open breaker symbol is shown, as this is the only
possible action.

All Mimic settings

The breaker symbol is shown in red:
« Breaker position failure

« Breaker close failure

The breaker symbol flashes green:
* The controller is synchronising
* The controller is de-loading

5.3  Running modes

The iE 150 BTB controller has three running modes. To configure the running mode push the Shortcut button and select
Running Modes.
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Mode _[Descripton

The controller automatically joins and splits the busbar. The operator cannot start a sequence manually. The

AUTO . . : .
controllers use the power management configuration to automatically select the power management action.

The controller cannot automatically join and split the busbar. The operator or an external signal can start these
MANUAL sequences. The controller automatically synchronises before closing a breaker, and automatically de-loads
before opening a breaker.

BLOCK The controller cannot start sequences. Select the block mode when you do maintenance work.
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6. Menus

6.1 Menu structure

The controller has two menu systems, which can be used without password entry:

+ The View menu system: Shows the operating status and values. The system has 20 configurable windows, that can be
entered with the arrow buttons.

« The Parameters menu system: The operator can see the controller's parameters. A password is necessary to change
the parameter settings.

6.2 Parameters menu

You can configure the controller in the parameters menu and you can also find information, which is not available in the

view menu. From the view menu, push the button to find the parameters menu. Use the and buttons to find

the different settings parameter and select with the button.

Parameters menu example
This is an example of how to change the nominal voltage settings.

% Logs

DG BLOCKED FOR START DG BLOCKED FOR START

PV 0ff Okvar OkW Push Parameters
G 0..00PF o | @ | Fa
G OkVa Okvar o Communication
&6 Engine
G energy Total 4kWh o I/0 Setup g
Generator
Run absolute Ohzrs -=_ Service View Busbar

1/20

Push

DG BLOCKED FOR START
Basic settings

Application type
Measurement setup

Nominal settings

Controller settings

DG BLOCKED FOR START
Nominal settings

Current
Frequency
Power

RPM

DG BLOCKED FOR START
Voltage

Generator nominal U

Busbar nominal U

Push

A 4

DG BLOCKED FOR START

Generator nominal U oot

Voltage: 400V
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6.21 Menu numbers

Each parameter has a menu number. You can find the number in the upper right corner on the display screen.

DG BLOCKED FOR START
Generator nominal U @

Voltage: 400V

You can also find the menu number with the utility software:

1. Select Parameters from the toolbar on the left.

2. Set the view mode to list. The view mode can be found in the left corner of the screen.
3. The menu numbers are in the Channel column.

6.2.2 The jump to parameter function
If you know the menu number for a parameter, you can use the jump to parameter function to go directly to the parameter.

On the controller

1. From the view menu, push the Shortcut button to see the jump to parameter function:

DG BLOCKED FOR START
Engine shortcuts
General shortcuts
Running mode

Start test

Lamp test

2. Use the and buttons to go to Jump to parameter and push the button.

DG BLOCKED FOR START
Engin‘ st

Gener ENTER MENU NO.:

0

Runni
Start test
Lamp test

3. Usethe and buttons to change the numbers, and push the button to save. Use the and @ buttons to

move to the next number.
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6.3 View menu

The view menu is shown when the controller is turned on, and you can see the operating status and values. The event and
alarms list is also shown if an alarm is active.

1T——— DG BLOCKED FOR START
U-Supply 25.9V
G 0.00PF OkW
2— G OkVa Okvar
Energy Total OkWh
Run absolute Ohzrs
3 1d:01 Prio:01 1/20

1. Operating status
2. Values and information
3. Page number, power management priority, power management ID and engine DEF level.

The view menu has 20 different display views. Use the and buttons to select a view.

iE 150 Generator example

DG BLOCKED FOR START DG BLOCKED FOR START

U-Supply 25.9V Push BB L1 0.00Hz OkWw

G 0.00PF Okw G L1 0.00Hz Okw

G OkVA Okvar G 0.00PF Okvar

Energy Total OkWh —> Energy Total OkWh

Run absolute Ohrs Run absolute Ohrs

Id:01 Prio:01 1/20 1d:01 Prio:01 2/20
iE 150 Shore example

SHORE FAILURE SHORE FAILURE

U-Supply 23.9V Push BB L1 0.00Hz oV

SC 0.00PF okw SC L1 0.00Hz ov

SC OkVA Okvar SC 0.00PF kW

Energy Total OokWh —» | SC OkVA Okvar

sC 0.00PF Okw N 0 OA
id:32 1/15 id:32 2/15

iE 150 BTB example

MANUAL OPERATION MANUAL OPERATION

U-Supply 25.9V Push BB L1 0.00Hz oV

BA L1 0.00Hz ov BA L1 0.00Hz ov

BA OkVA Okvar BA OkVA Okvar

BA 0.00PF OkWh —> BA 0.00PF okw

BA 0 Okw BA 0 0A
1d:33  1/20 1d:33  2/20

6.3.1 Display views

The controllers have 20 different display views, and some are pre-configured. You can configure the views with the utility
software.
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iE 150 Generator

G 0.00PF OkW Speed detection Run absolute Ohrs G0OOO0V Energy total OkWh
2 G 0.00kVA Okvar Water temp. detection Serv 1 0d Oh GO0OOA Date and Time
3 G L1 0.0Hz OV Oil pres. detection Start attempts O G 0.00 0.00 0.00Hz SCB operations O
4 GO0O0O0A Fuel level detection D+ Voltage OV gg('): By GB operations 0
5 BB L1 0.0Hz OV U-Supply 0.0V = G 0 0 OkW =
After treatment Engine dashboard EIC T. Coolant L-L and P total
2 Synchroniser Il EIC Tier 4 Icons EIC Engine Icons EIC T. Turbo Oil Current and Q total
3 - - - EIC T. Exh. Right Pf and kW %
4 - - - EIC T. Oil GOV and AVR
output
5 - EIC Regeneration info = EIC T. Fuel Ramp.down/up
setpoint
P GTot and P % G Angle L1L2 Odeg P OkW 0% P available OkW BB-Gen Angle Odeg
2 Q GTot and Q % G Angle L2L3 Odeg Q Okvar 0% P available 0% G Angle L1L2 Odeg
4 BB freqand G freq G Angle L3L1 Odeg S OkVA 0% P consumed OkW gge/zngm LiL2
4 BBL-Nand GL-N  AVR reg. type - P consumed 0% (B)Sezngle L2L3

5 kW % and kvar % GOV reg. type - - -

1 G U-L1L2 OV G f-L1 0.00Hz Supervision - -
drawing

2 GU-L2L3 OV G f-L2 0.00Hz - - -

3 GU-L3L10V G f-L3 0.00Hz - - -

4  GU-Max OV - - - -

5  GU-Minov - - - -

iE 150 Shore controller

U-Supply 0.0V BB L1 0.0Hz OV SC0O0o0V SC P OkW
2 SC 0.00PF OkW SC 0.0Hz OV Synchroniser SC L1 0.0Hz OV SC Q Okvar
3 SC OkVA Okvar SC 0.00PF OkW - - SC S OkVA
4 Energy Total OkWh SC OkVA Okvar - BB 0O 0O OV SCoooVv
5 SC 0.00PF OkW SCO0O00A - BB L1 0.0Hz OV SCO0O0D0A
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a b W N

SC I-L1 0A
SCI-L2 OA
SCI-L3 0A
SC 0.00PF OkW
SC000V

SC f-L1 0.00Hz
SC f-L2 0.00Hz
SC f-L3 0.00Hz
SC 0.00PF OkW
SCO000V

SC U-L1N OV
SC U-L2N oV
SC U-L3N OV
SC f-L1 0.00Hz
SCO00O0A

P available OkW

P consumed OkW

P OkW 0%
Q Okvar 0%
S OkVA 0%

SC U-L1L2 oV

SC U-L2L3 OV
SC U-L3L1 0V

SC f-L1 0.00Hz
SC00O0A

a b W N

BB U-L1L2 OV

BB U-L2L3 OV
BB U-L3L1 0V

BB f-L1 0.00Hz
SCO0O0O0A

iE150 BTB

a b W N

U-Supply 0.0V

BA L1 0.0Hz OV
BA OkVA Okvar

BA 0.00PF OkW
BA 0 0 0A

SC U-LIN OV

SC U-L2N oV

SC U-L3N 0V

SC 0.00PF OkW
Energy Total OkWh

BB L1 0.0Hz OV
BA L1 0.0Hz OV
BA OkVA Okvar
BA 0.00PF OkW
BA 00 OA

Multi Input 20 0
Multi Input 21 0
Multi Input 22 0
Multi Input 23 O

Synchroniser

Date and Time

SCB operations 0O

BAO OOV
BA f-L1 0.00Hz
BB 0 0 OV
BB f-L1 0.00Hz

BB-M Angle Odeg

SC Angle L1L2 Odeg
SC Angle L2L3 Odeg
BB Angle L1L2 Odeg
BB Angle L2L3 Odeg

BA P OkW
BA Q Okvar
BA S OkVA
BA OO OV
BA 0 0 OA

a b W N

BA I-L1 0A
BA I-L2 0A
BA I-L3 OA
BA 0.00PF OkW
BAO OOV

BA f-L1 0.00Hz
BA f-L2 0.00Hz
BA f-L3 0.00Hz
BA 0.00PF OkW
BA OO OA

BA U-L1L2 OV

BA U-L2L3 OV
BA U-L3L1 0V

BA f-L1 0.00Hz
BA OO OA

BB U-L1L2 OV
BB U-L1L2 OV
BB U-L3L1 0V
BB f-L1 0.00Hz
BA OO OA

Multi Input 20 0
Multi Input 21 0
Multi Input 22 0
Multi Input 23 0

a b W DN

6.3.2 Display text

Date and Time

BTB Operations O

Angle BB-BA Odeg

BA Angle L1L2 Odeg
BA Angle L2L3 Odeg
BB Angle L1L2 Odeg
BB Angle L2L3 Odeg

Configure the display views
You can configure the display views with the utility software.

1.
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Select Tools > Display views in the left-hand menu.
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Monitoring

“

“

Configuration

Tools 3

Ethernet setting (TCP/IP)
M-Logic & AOP

Maodbus Configurator
Option & Firmware

Translations

| Display views

Permissions

Compare offline files

2. Select the display line you want to change.
3. In the pop-up window, select the text you want and click OK.

- Analoge inputs

-Counters and timers

- Digital automatic voltage regulator
-Electrical data

- Engine communication

-Info

-LED lamps

-M-Logic controlled custom view-ines
-Mo text

- Supervision

WOW W W W W W W W W

Display text
You can select five of the display texts for each display view.

6.4  Status texts

S

ACCESS LOCK Izjsconﬂgurable input is activated, and the operator tries to activate one of the blocked

ADAPT IN PROGRESS Power management: The controller is receiving the application it has connected to.

BTB power management: BTB controller is in AUTO mode, but is not ready for breaker

GLIRHOIEE Ao operation (because of an active BTB trip alarm).

Aux. test ##.#V H##H#s The battery test is activated.

BLACKOUT ENABLE Generator power management: CAN failure in a power management application.
BLOCK Block mode is activated.

BLOCKED FOR CLOSING BTB power management: Last open BTB in a ring bus.
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BROADCAST ABORTED
BROADCASTING APPL. #
BROADCAST COMPLETED
BTB TRIP EXTERNALLY

BTB XX DIVIDING SEC.
COMPENSATION FREQ.
COOLING DOWN ###s
DELOAD

DELOADING BTB XX

DERATED TO #####kW
DG BLOCKED FOR START
DIVIDING SECTION
EXT. STOP TIME ###s
FIXED POWER ACTIVE
FIXED POWER AUTO
FIXED POWER MAN
FIXED POWER NoReg
FULL TEST

FULL TEST ###.#min
GB ON BLOCKED

GB TRIP EXTERNALLY
GENSET STOPPING
Hz/V OK IN ###s

IDLE RUN
IDLE RUN ###.#min

ISLAND ACTIVE

ISLAND AUTO

ISLAND MAN

ISLAND NoReg
Loadshare conf error
LOAD TAKE OVER AUTO
LOAD TAKE OVER MAN
LOAD TEST

LOAD TEST ###.#min
LTO ACTIVE
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Power management: Broadcast terminated.

Power management: Broadcast one of the four applications from one controller to the
other controllers in the power management system, through the CAN line.

Power management: Correct broadcast of an application.

BTB power management: External equipment has tripped the breaker, and this is logged
in the event log.

Generator power management: BTB XX is dividing two sections in an island application.
Compensation is active. The frequency is not at the nominal setting.

Cooling-down period is activated.

The controller is decreasing the load of the genset in order to open the breaker.

Generator power management: Genset controllers are load sharing asymmetrically to de-
load BTB XX.

Displays the ramp-down set point.

The generator has stopped and has active alarm(s).

BTB power management: A BTB unit is dividing two sections in an island application.
The extended stop timer is running.

The controller is in auto mode and supplying fixed power.

The controller is in auto mode and ready to respond.

The controller is in manual mode and waiting for operator input.

The controller is in no reg mode and waiting for operator input.

Test mode is activated.

Test mode is activated and test timer counting down.

The generator is running, the GB is open and there is an active Trip GB alarm.

Some external equipment has tripped the breaker. An external trip is logged in the event
log.
Cooling down has finished.

The voltage and frequency on the genset is OK. When the timer runs out the generator
breaker can be closed.

The Idle run function is active. The genset does not stop until a timer has expired.
The Idle run function is active. The genset does not stop until the timer has expired.

The controller is in auto mode and supplying power while not connected to a shore
connection supply.

The shore controller is in auto mode and ready to respond.

The controller is in manual mode and waiting for operator input.
The controller is in no reg mode and waiting for operator input.
Analogue load sharing is selected, but there is no IOM.

The shore controller is in auto mode and ready to respond.

The controller is in manual mode and waiting for operator input.
Test mode is activated.

Test mode is activated and test timer counting down.

The controller is in auto mode and taking over the load.
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MAN OPERATION
MOUNT CAN CONNECTOR
QUICK SETUP ERROR

RAMP TO #####kW

READY AUTO OPERATION

READY FIXED P AUTO
READY ISLAND AUTO
READY LTO AUTO
RECEIVING APPL. #
RECEIVE COMPLETED
RECEIVE ERROR

REMOVE CAN CONNECTOR

SCB TRIP EXTERNALLY

SELECT GENSET MODE
SETUP COMPLETED
SETUP IN PROGRESS
SHORE FAILURE

SHORE FAILURE IN ###s

SHORE f OK DEL ####s

SHUTDOWN OVERRIDE
SIMPLE TEST
SIMPLE TEST ###.#min

START DG(s) IN ###s

START PREPARE

START RELAY OFF
START RELAY ON

STOP DG(s) IN ###s
SYNCHRONISING BTB XX
SYNCHRONISING SCB XX

TOO SLOW 00¢——----------

-------- —— 00 TOO FAST

UNEXPECTED GB ON BB
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BTB power management: BTB unit in MANUAL mode.
Power management: Connect the power management CAN line.
Power management: Failure of the quick setup of the application.

The power ramp is ramping in steps. The next step that is reached after the timer has
expired is displayed.

BTB power management: BTB unit in AUTO mode and ready for breaker operation (no
active BTB trip alarm).

The genset controller is in auto mode and the genset is stopped.
The genset controller is in auto mode and the genset is stopped.
The genset controller is in auto mode and the genset is stopped.
Power management: The controller is receiving an application.
Power management: Application received correctly.

Power management: Application is not received correctly.

Power management: Remove the power management CAN lines.

Power management: Some external equipment (not the controller) has tripped the
breaker. An external trip is logged in the event log.

Power management is deactivated and no other genset mode is selected.

Power management: Correct update of the application in all controllers.

Power management: The new controller is being added to the existing application.
Shore connection failure and shore connection failure timer expired.

The frequency or voltage measurement is outside the limits. The timer shown is the
shore connection failure delay.

Shore connection frequency is OK after a shore connection failure. The timer shown is
the shore connection OK delay.

The configurable input is active.
Test mode is activated.
Test mode is activated and test timer counting down.

The start genset set point has been exceeded. The genset starts when the timer
expires.

The start prepare relay is activated.

The start relay is deactivated during the start sequence.

The start relay is activated.

The stop genset set point has been exceeded. The genset stops when the timer expires.
Generator power management: BTB XX is synchronising.

Generator power management: SCB XX is synchronising.

Generator running too slow during synchronisation.

Generator running too fast during synchronisation.

Another generator breaker is closed on to the busbar (due to a GB position failure) while
no voltage is present on the busbar. This shows that other breakers cannot close to the
busbar because of position failure on one or more GBs.
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Warm up ramp is active. The available power is limited until the pre-defined temperature

WARM UP RAMP . . . . .
v is reached, or when the input that activated warm up ramp is deactivated.

Generator is synchronising. The "xx" marks the actual generator phase angle position in
———XX====—=—- >00< -——-——-—-—--——- the synchronisation. When the "xx" is aligned over the 00 centre, the generator is
synchronised.
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6.5 Service view

You can use the service view to see the status of the controller. You can change the passwords in the service menu, but not
the other controller settings.

From the view menu, push the button and select Service View . Use the and . buttons to go through the

parameters in the service view, and use the button to select the parameters.

Service view example

DG BLOCKED FOR START ? Logs DG BLOCKED FOR START
U-Supply 25.9Vv Push Push Service View
G 0.00PF OkW R :.O Parameters Password
G OkVa Okvar L6 Parameter filter
Energy Total okh P gy 1/0 Setup ) euS
Run absolute onrs =serviceviev ] Counters

1d:01  Prio:01  1/20 L

Push v

DG BLOCKED FOR START
I/0 status
Status binary input

Status relay output

Status analog input
Status analog output

Push v

DG BLOCKED FOR START
Service menu

Run coil relay

Start relay
Start prepare
Stop coil relay
Status ok

o

PO O O

6.6 General shortcuts

You can see your configured shortcuts in the General shortcuts menu. If you have not configured a shortcut, then the menu
is empty. Use the shortcuts when the controller is in MANUAL and No reg mode.

More information
See General shortcuts in the iE 150 Generator, Shore, and BTB Designer's handbook for how to configure the
general shortcuts.

On the controller

1. From the view menu, push the Shortcut button to see the menu.

BLOCKED FOR START
Engine shortcuts

General shortcuts

Jump to parameter
Running mode
Start test

Lamp test

L J

2. Use the Up and Down buttons to go to General shortcuts , and push the button.
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BLOCKED FOR START
SC Switch 1 off

SC Pulse 1

L J

3. Use the Up and Down buttons to go to select a shortcut.

6.7 iE 150 Generator menus
6.71 1/O Setup menu
You can configure digital inputs, multi inputs, digital outputs, and external inputs/outputs on the controller.

On the controller

Push the OK button to see the different menus.

1.
2. Select I/O Setup.
3. Select the type of input you want to configure, for example digital inputs.
4. Select the digital input you want configure, for example digital input 39.
5. Configure the parameters for digital input 39.
1/0O Setup example
DG BLOCKED FOR START ? N DG BLOCKED FOR START
Q Logs
U-Supply 25.9V Push Push I/0 Setup
G 0.00PF oKW | Parameters
ox)
G OkVa Okvar yc} Output menu
Energy Total ok —P Py | External 1/0
Run absolute Ohrs ﬁ Service View

Push l

DG BLOCKED FOR START
Input menu

Digital input

Multi input

Push l

DG BLOCKED FOR START
Digital input
Digital input 40
Digital input 41
Digital input 42
Digital input 43

Push L

DG BLOCKED FOR START
Digital input 39
Enable: OFF

Text: Digital input 39
Type: High

Delay: 10.0s
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6.7.2 Engine shortcuts menu
6.7.2.1 ECU Diagnose

You can activate ECU diagnose from the engine shortcuts menu. Use ECU Diagnose to read ECU data without starting the
engine.

To activate ECU diagnose on the controller:

1. Push the Shortcut button.

2. Select Engine shortcuts.
3. Select ECU Diagnose.

The diagnostics timer is activated when you select ECU Diagnose, and the controller starts to read the ECU data when the
diagnostic timer expires. To configure this timer, go to Parameters in the utility software and select parameter 6701.

6.7.2.2 Force Regeneration
You can inhibit or force regeneration from the engine shortcuts menu.

To inhibit or force regeneration:

Push the Shortcut button.

Select Engine shortcuts.
Select Force Regeneration.

N

Select Inhibit or Force.
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/. Alarm handling and log list

7. Alarm handling

If the function Alarm Jump is on, the controller automatically shows the alarm list on the display screen when an alarm
occurs.

Service View > Display > Alarm Jump

T ——

OFF

9157 Alarm Jump ON

Access the alarm list from the controller

1. From the view menu, push the button.

2. Use the and buttons to go to the Alarm list.
|O‘| Parameters

%0 I/0 Setup

P . .
™| Service View

AN

3. Push the button to view the Alarm list.

4. Push the button to go back.

The alarm list contains both acknowledged and unacknowledged alarms that are active. An alarm is active, if you have not
cleared the alarm condition, which started the alarm. Once an alarm is acknowledged and you have cleared the alarm
condition, the alarm is removed from the alarm list. If there are no alarms, then the alarm list shows No alarms.

The display screen can show only one alarm at a time. The number of alarms is shown on the right at the bottom of the
screen.

Example of an unacknowledged alarm

DG BLOCKED FOR START
Alarm list

Ch 3490 UNACK
Val:Low Sp:High
Failclass: Shutdown

1/2 alarm(s)

To see the other alarms, use the and buttons to go through the list. To acknowledge an alarm, select the alarm and

push the button.

Access the alarm list with the utility Software
Select Alarms from the left toolbar.
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/A\ CAUTION

Caution

If an alarm is blocking a genset in AUTO mode from starting, the genset automatically starts if the condition that

triggered the alarm has gone and the alarm has been acknowledged.

711 Self-check errors

When an iE controller is connected to a DVC 550 or D550 digital AVR, a Self-check error alarm might be activated in the iE.

For all of these alarms, the alarm action is BLOCK.

If a Self-check error alarm is activated in the iE controller, contact DEIF support. We will help you to fix the problem and

clear the alarm.

7.2 Logs menu

These are the log sub-menus:
1. Event log: Shows up to 500 events.

2. Alarm log: Shows up to 500 alarms. Only the latest 100 alarms are shown on the display unit, while the remaining alarms

are shown in the utility software.
3. Battery test log: Shows up to 52 tests, either Test OK or Test failed.

Access the log menu from the controller

1. From the view menu, push the button.
2. Use the and buttons to go to Logs.

2 er——

E:" Parameters
[Fd

Yo

0 I/0 Setup

L . .
] Service View

3. Pushthe button to select Logs.
4. Select the log you want to see and push the button.

GEN BLOCKED FOR START

Event log

Alarm log

Battery test log
ECU Alarm(s) DM1 1st
ECU Alarm(s) DM1 2nd
ECU Hist. alarms DM2

5. To leave the Log , push the button.

Access the log list with the utility software
1. Select Logs from the menu on the left.
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2. In the task bar, select Read logs 244
3. Select the Log list you want to see.
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